
About

Displays a dialog box with copyright and version information for ZAURUS Mail.



Accessing your mailbox
The main screen of Message Center displays a mailbox button for each user that has been 
configured by the Message Center Administrator, up to a maximum of 20 users. Each 
mailbox is protected by a password (which is initially set by your Administrator) which must 
be entered before access to the mailbox is granted.

To access your mailbox:

Note: If a mailbox other than your own is currently open, select Close Mailbox from the File 
menu.

1
.

Select your mailbox button in either of the following ways:

o
o

Click on the button using a mouse, or
Use the arrow keys to highlight the name under your mailbox button,
and select Open Mailbox from the File menu.

2
.

The Open Mailbox dialog box will appear, prompting you for your 
password. Enter your mailbox password, and select the OK button. 
Your mailbox folders are displayed.

Related topics:
In folder
Out folder
Sent folder
Creating a new message
Answering a message
Forwarding a message
File menu



Adding attachments
To add attachments to a message you are creating, select the Attach button in the New 
Message screen. Any attached data files are listed in the Attachments window. The file 
name, description, type, and size of each file is shown.

Attachments can be either PC files (without any conversion) or data imported from a file of a
supported file format that is converted to ZAURUS application data. Imported data is 
consolidated into ZAURUS Filer folder attachments. When received by a ZAURUS user, these 
Filer folder attachments may be detached, and the contents of the folder will be merged with
the user's other application data.

To add attachments:

PC files
      

1
.

Select the Attach button in the Attachments window. A standard file 
selection dialog box is displayed.

2
.

Select the file to be attached and select the OK button.

3
.

Enter a description for the selected file in the Attachment 
Description, and select the OK button. The file is added to the list of 
attachments.

4
.

Repeat steps 1 - 3 for any additional files you wish to attach. When 
you are done, select the OK button in the Attachments dialog box.

ZAURUS Filer folders
      

1
.

Select the Import button in the Attachments dialog box to create a 
new Filer Folder attachment. The Import ZAURUS Filer Folder dialog 
box is displayed.

2
.

Enter a name for the Filer Folder in the Folder Name field.

3
.

Select the Import button in the Filer Folder dialog box. The Import 
dialog box is displayed, allowing you to select the ZAURUS 
application you wish to import to (e.g. Appointments, To Do, Contact 
1, etc.), and select the data file to import.

4
.

In the Import dialog box, the settings for ZAURUS application, file 
name, file format, field maps, etc. are provided. See Import for more 
information.
When the settings are complete, select the Import button. The 
import process begins. When the import is completed, select the OK 
button of the confirmation dialog box that appears. Repeat steps 3 
and 4 to add any additional entries to the same Filer Folder.

5
.

Select the OK button in the Import ZAURUS Filer Folder dialog box to 
close the Filer Folder. The Attachment Description dialog box 
appears.



6
.

Enter an optional description for the Filer Folder, and select the OK 
button. You return to the Attachments list. Repeat steps 1-6 as 
necessary to attach additional Filer Folders 

To add additional entries to an existing Filer Folder attachment:
      

1
.

Open the desired Filer Folder by selecting it in the Attachments 
dialog box, and selecting the Modify button. The Import ZAURUS Filer
Folder dialog box is displayed.

2
.

Follow steps 3 and 4 above for adding new entries to a Filer Folder.

Related topics:
Creating a new message 
Answering a message 
Forwarding a message 
The Out Folder 
Sending a message 
Viewing Filer folder attachments
Deleting attachments



Adding users
The Message Center Administrator must add each new user before those users may access 
Message Center. 

To add new users:

Note: Managing users can only be done when the Administrator
is logged into the Administrator account. The menu items
mentioned below do not appear when a user is logged 
into a normal user account.

1
.

Select User List from the File menu. The Users dialog box is 
displayed, showing the Administrator and currently configured
user accounts, if any.

2
.

Select the Add button. The Add User dialog box is displayed.

3
.

Enter the following information to setup the new user:

Name:

User ID:

Password:

Retype 
Password:

Pager Service: 

PIN:

Enter the user's name (e.g. Smith, Joe). This 
must be unique among all users.

Enter a User ID (up to 14 characters) for the 
user. It is recommended that you use the 
first initial and last name of the user (e.g. 
jsmith). This must be unique among all 
users.

Enter the user's initial password (up to 7 
characters). The user can change their 
password when they log in.

Retype the entered password.

If the user would like to have the ability to 
selectively forward their messages to a 
pager, select their pager company from the 
Pager service drop-down list. See Pager 
Service Setup for more information on how to
configure pager services.

Enter the user's pager id number (not 
including "800" if it is an 800 number).

Select the OK button when you are done. The new user is 
added to the Users list.

4
.

Repeat steps 2 and 3 for any additional users you wish to add.

5
.

When you are done adding users, select the OK button in the 
Users dialog box.

6 You are then asked if you would like to send an updated list of



. users to all Message Center users. Select the Yes button to 
automatically generate and send the appropriate message, or
the No button to avoid doing so.

Related topics:
Modifying users
Deleting users
Sending the User List 
File menu



Addressing a message
ZAURUS Message Center provides a convenient Address Book for addressing messages to 
other users. The Address Book is displayed when you select the Address button while 
creating a new message. Recipients of your message can be designated as To:, Cc:, or Bcc:.

To address a message:
      

1
.

Select the Address button in the new message screen. The Address 
dialog box is displayed.

2
.

Select the desired To: recipients from the Address Book list on the left
(multiple recipients may be selected in the standard way using the 
Shift or Ctrl key in combination with the mouse), and select the To: 
button. The select recipients are added to the To: list on the right.

3
.

Repeat step 2 for any Cc: and/or Bcc: recipients.

4
.

Select the OK button when you are done.

To remove recipients from a message:
      

1
.

Select the Address button in the new message screen. The Address 
dialog box is displayed.

2
.

Select the desired To: recipients in the To: list on the right (multiple 
recipients may be selected in the standard way using the Shift or Ctrl
key in combination with the mouse), and select the Remove button. 
The select recipients are removed from the To: list.

3
.

Repeat step 2 as desired for any Cc: and/or Bcc: recipients.

4
.

Select the OK button when you are done.

Note: Recipients can only be added to a message using the Address Book. They cannot be 
entered directly in the new message screen.

Related topics:
Creating a new message 
Answering a message 
Forwarding a message 
Sending a message 
The Out Folder 



Answer

Creates a reply to the current message. A pre-addressed new message creation form is 
opened, optionally including the contents of the message you are answering.

Related topics:
Answering a message



Answering a message
Message Center provides the ability to answer a message you have received from another 
user.

To answer a received message:

1
.

Select the message you wish to answer in the In Folder, and select 
Answer from the Message menu. The Answer Message dialog box is 
displayed.

2
.

Choose to:

Answer Author Only:
Answer All Recipients:
Include Original 
Message:

Answer only the sender of the original message.
Answer all of the recipients of the original 
message.
When this check box is set, the original 
message is included in the body of the new 
message.

Select the OK button when you have completed your selections.

3
.

The remaining steps are the same as when creating a new message.

Related topics:
Accessing your mailbox
Adding attachments 
Addressing a message 
Sending a message 
The Out Folder 
Creating a new message 
Forwarding a message 
Message menu



Modem Baud Rate

Select the baud rate your ZAURUS users' and Message Center modems both support, up to a
maximum of 19.2K BPS.



Modem COM Port

Select the COM port to which your modem is attached. If you will not be using modem 
communications, set the COM Port to None.



Close Mailbox

Closes the currently open mailbox, returning you to the main screen showing all of the user 
mailbox buttons.

Related topics:
Accessing your mailbox



Communicating via IR/Cable
Any of the following can be used for a local connection between your ZAURUS and PC for 
Message Center communications:

o SHARP CE-IR4 Wireless Interface (infrared).

o Aegis PC-Link cable (from the special offer on the ZAURUS 
registration card).

o Any PC-Link cable originally designed for use with a SHARP Wizard 
electronic organizer (e.g. SHARP CE-133T Level Converter, SHARP 
CE-137T Level Converter).

o Any Wireless Interface originally designed for use with a SHARP 
Wizard electronic organizer (e.g. SHARP CE-IR2).

Please call 1-800-BE-SHARP for information on how to order any of the products above.

SHARP CE-IR4 Wireless Interface

1
.

Turn off your PC and CE-IR4 unit.

2
.

Attach one end of the RS-232C cable to the RS-232C port (COM1-
COM4) of your PC.

3
.

Attach the other end of the RS-232C cable to the port on the CE-IR4.

4
.

Make sure the CE-IR4 has power, either using batteries or the 
optional SHARP EA-11E AC Adaptor.

5
.

To communicate, make sure the infrared port on your ZAURUS faces 
the infrared port (front) of the CE-IR4 Wireless Interface, and that 
they are no more than 20 inches (50 centimeters) apart. Also, be 
sure to turn the CE-IR4's power on before attempting 
communications.



Aegis Cable

1
.

Turn off your PC and ZAURUS.

2
.

Connect the 15-pin end of the Aegis cable to the 15-pin cable jack of 
your ZAURUS (marked COMPUTER LINK on the left edge of the 
keyboard). 

3
.

Attach the 9-pin end of the Aegis cable (or use the 9-to-25-pin 
adapter, if necessary) to the RS-232C port (COM1-COM4) of your PC.

Related topics:
Sending a message (on ZAURUS) 
Sending a message (on PC) 
Receiving messages 



Communication

Allows you to configure various ZAURUS Mail communication settings. This menu item only 
appears when the Administrator is logged in.

Related topics:
Communication setup



Communication setup 
ZAURUS Message Center can communicate with "Zauri" (plural of ZAURUS) over a dial-up 
modem, via infrared (IR), or via a cable connection. Naturally, each method is suitable for 
specific circumstances, such as use of IR or cable when you are in the same location as the 
ZAURUS Mail PC, and use of a modem connection when you are away.

Message Center can use up to two (2) serial ports on your PC for communication; one for a 
modem, and a second for either IR or cable. The Message Center Administrator must 
configure communications before a ZAURUS can "talk" to Message Center.

Step-by-step instructions

Click on the area of the window you would like more information about:

Related topics:
Options menu



Communication setup - step-by-step
To setup communications:

1
.

Select Communication from the Options menu. The Communication 
dialog box is displayed.

2
.

In the Modem group, check the following settings:

COM Port: Select the COM port to which your modem is attached. If 
you will not be using modem communications, set the 
COM Port to None.

Baud Rate: Select the baud rate your ZAURUS users' and Message 
Center modems both support, up to a maximum of 19.2K 
BPS.

Initialization: If your modem requires a special initialization string, 
enter it here. Message Center's default initialization string
will work with most Hayes-compatible modems. Selecting 
the Default button will reset the string to its factory 
default.

Dialing: Select the appropriate dialing type for the phone line 
being used for communication. If you wish to hear the 
modem tones when a connection is being established 
(when users are calling in), check the Modem Speaker On 
box. Otherwise, uncheck the box to avoid being distracted
by the noise.

3
.

In the IR/Cable group, check the following settings:

COM Port: Select the COM port to which your IR unit or cable is 
attached. If you will not be using IR or cable 
communications, set the COM Port to None.

Connection 
method:

Select the appropriate connection method that you are 
using; Cable, CE-IR2 (wireless infrared), or CE-IR4 (IrDA 
compatible wireless infrared).

4
.

Select the OK button when you have completed your settings. 
Message Center will immediately attempt to initialize your modem (if
the Modem COM Port is set to something other than None), so please
make sure it's power is turned on before you select the OK button 
(this applies to external modems only since internal modems always 
have power when the PC is on). 

Related topics:
Communication setup
Preferences setup
Pager Service setup
Message Server setup 



Contents

Displays the Contents page of this on-line help.



Copy

Copies the currently selected text to the Windows clipboard.



Copy to Out Folder

Copies a previously sent message from the Sent folder to the Out folder so that the message
may be modified and resent.



Creating Export Field Mappings
Export field mappings allow you to define the order that fields are exported in, as well as the
combining and splitting of fields. The end result is very fine control of how ZAURUS data is 
exported to a file that may be imported into another application. Export field mapping only 
applies to exporting of data to .CSV and .SDF files.

To create export field mappings:

Not
e:

the ability to create export field mappings depends upon the 
currently selected application and export file format.

1
.

Select the New button in the Field Mapping box of the Export dialog box. 
The New Mapping dialog box is displayed.

2
.

Enter a name for the new field map in the Mapping Name field (up to 20 
characters).

3
.

Source File fields can optionally be divided into 1-4 fields using the Split 
Field function. The divided fields can then be mapped individually to the 
Destination File.

4
.

If the Destination File requires fewer or more fields than the default 
number, it can be changed in the Number of Export Fields box. Simply 
use the arrows to increment or decrement the current value (you can 
specify between 1 and 32 fields).

5
.

Select each field in the Source File list, and copy it to the desired 
Destination File field. This can be done in two ways:

o After selecting the field in the Source File list, select the field to copy 
it to in the Destination File list, and then select the Add> button. The 
field from the Source File list is shown in the Destination File list. 

You may copy multiple fields from the Source File list to the same 
field in the Destination File. Simply continue selecting fields in the 
Source File and select the Add> button without changing the 
Destination File field selection (a maximum of 4 Source File fields can
be mapped to the same Destination File field). The currently selected
Separator character will be inserted between fields automatically. 
The Separator can be changed using the Change Separator drop-
down list. The available separators are:

*
*
*
*
*
*

*

[,] - Comma
[SP] - Space
[CR] - Carriage Return
[NO] - No Separation
[/] - Slash
[+] - Start Time+Duration
Add the Start Time to the Duration to get the End Time.
Note: The Duration is shown in minutes.
[-] - End Time-Start Time
Subtract the End Time from the Start Time to get the Duration.



o Select the Map All> button to copy all of the Source File fields to the 
Destination File automatically. Each Source File field is copied to the 
corresponding Destination File field.

6
.

If necessary, you can remove fields from the Destination File list. To 
remove a field, do the following:

o

o

Select the desired field in the Destination File list, and then select the
Remove button.
Or
Select the Clear All button to remove all fields from the Destination 
File list.

7
.

When you're finished, select the OK button.



Creating Import Field Mappings
Import field mappings allow you to reorder the fields of the import file to match the selected 
ZAURUS application, as well as splitting and combining of fields. The end result is very fine 
control of how files are imported into ZAURUS Filer folders. Import field mapping only applies
to importing of .CSV and .SDF files.

To create import field mappings:

Not
e:

the ability to create import field mappings depends upon the 
currently selected application, the import file format, and entering or 
selecting an import filename.

1
.

In the Import dialog box, select the New button in the Field Mapping box. 
The New Mapping dialog box is displayed.

2
.

Enter a name for the new field map in the Mapping Name field (up to 20 
characters).

3
.

Source File fields can be divided into 1-4 fields using the Split Field 
function. The divided fields can then be mapped individually to the 
Destination File.

4
.

The first record of the data to be imported is shown next to each field in 
the Source File field list. To view other records:

o
o

Select the Prev button to display the previous record.
Select the Next button to display the next record.

5
.

Select each field in the Source File list, and copy it to the desired 
Destination File field. This can be done in two ways:

o After selecting the field in the Source File list, select the field to copy 
it to in the Destination File list, and then select the Add> button. The 
field from the Source File list is shown in the Destination File list. 

You may copy multiple fields from the Source File list to the same 
field in the Destination File. Simply continue selecting fields in the 
Source File and select the Add> button without changing the 
Destination File field selection (a maximum of 4 Source File fields can
be mapped to the same Destination File field). The currently selected
Separator character will be inserted between fields automatically. 
The Separator can be changed using the Change Separator drop-
down list. The available separators are:

*
*
*
*
*
*

*

[,] - Comma
[SP] - Space
[CR] - Carriage Return
[NO] - No Separation
[/] - Slash
[+] - Start Time+Duration
Add the Start Time to the Duration to get the End Time.
Note: The Duration is shown in minutes.
[-] - End Time-Start Time



Subtract the End Time from the Start Time to get the Duration.

o Select the Map All> button to copy all of the Source File fields to the 
Destination File automatically. Each Source File field is copied to the 
corresponding Destination File field.

6
.

If necessary, you can remove fields from the Destination File list. To 
remove a field, do the following:

o

o

Select the desired field in the Destination File list, and then select the
Remove button.
Or
Select the Clear All button to remove all fields from the Destination 
File list.

7
.

When you're finished, select the OK button.



Creating a new message
Message Center's primary function is to allow you to correspond with other users via 
electronic mail. Naturally, this starts with creating a new message to send to another user.

To create a new message:

1
.

Select New from the Message menu, or click on the New tool bar 
button. A blank message creation screen is displayed.

2
.

Select the Address button to open the Address Book and address the 
message. See Addressing a message.

3
.

Set the message priority by selecting Low, Normal, or High in the 
Priority drop-down list. Your priority selection here will determine 
which icon is shown next to the message when it is delivered to the 
recipients.

4
.

Enter a brief subject in the Subject field, up to 30 characters long.

5
.

Enter your message in the Message box, up to 2048 characters.

6
.

Select the Attach button if you wish to attach any files to the 
message. See Adding attachments.

7
.

If you would like a notification message when the recipients open 
your message, select the Return Receipt check box. 
If you would like the message saved in the Sent folder after it is sent,
make sure the Save Sent Message check box is selected.

8
.

When you are done, you may send the message immediately, or wait
and send it later. See Sending a message.

Related topics:
Accessing your mailbox
Adding attachments 
Addressing a message 
Sending a message 
The Out Folder 
Answering a message 
Forwarding a message 
Message menu



Cut

Cuts the currently selected text to the Windows clipboard.



De-select All

De-selects all of the messages in the current folder.



Delete

Deletes the currently selected text without copying it to the Windows clipboard.



Delete

Deletes the currently selected messages in the current folder.

Related topics:
Deleting messages



Delete messages after

Check the Delete messages after box to have old messages automatically deleted when 
they become old. You may change the number of days after which they should be deleted by
clicking on the arrows (or entering a new value directly).



Deleting Export Field Mappings
To delete an export field mapping:

Not
e:

the accessibility of a specific export field map depends upon the 
currently selected application and export file format.

1
.

In the Export dialog box, select the field map to be deleted from the 
Currently Selected Map list.

2
.

Select the Delete button, and then select the Yes button in the 
verification dialog box that appears.



Deleting Import Field Mappings
To delete an import field mapping:

Not
e:

the ability to delete import field mappings depends upon the 
currently selected application, and the import file format.

1
.

In the Import dialog box, select the field map to be deleted from the 
Currently Selected Map list.

2
.

Select the Delete button, and select the Yes button in the 
confirmation dialog box that appears.



Deleting attachments
You may delete PC file and ZAURUS Filer folder attachments on messages you have created 
or received. In addition, you may also delete selected entries from attached ZAURUS Filer 
folders, instead of deleting the entire folder.

To delete attachments:

PC files and entire ZAURUS Filer folders

1
.

While in the detail view of the desired message, select the Attach 
button. The Attachments dialog box is displayed.

2
.

Select the desired files and or folders to delete, and select the Delete
button. The Verify Delete dialog box is displayed.

3
.

Select the Yes button to confirm that you want to delete the selected 
entries.

ZAURUS Filer folder entries
      

1
.

While in the detail view of the desired message, select the Attach 
button. The Attachments dialog box is displayed.

2
.

Open the desired Filer Folder by selecting it in the Attachments 
dialog box, and selecting the Modify button. The Import ZAURUS Filer
Folder dialog box is displayed.

3
.

Select the Filer Folder entries to delete, and select the Delete button.
The Verify Delete dialog box is displayed.

4
.

Select the Yes button to confirm that you want to delete the selected 
entries.

Related topics:
Adding attachments
Detaching attachments



Deleting messages
You may delete messages in any of the three message folders; In, Out, and Sent.

To delete messages:

1
.

Select the message you wish to delete. If you are in Index 
view, you may select multiple messages to delete.

2
.

Select Delete from the Message menu, or click on the Delete 
tool bar button. A verification dialog box is displayed.

3
.

Select the Yes button to delete the selected message(s), or 
the No button to avoid doing so.

Related topics:
The Out Folder 
The In Folder 
The Sent Folder 
Searching messages 
View Filter 
Message menu



Deleting users
The Message Center Administrator can delete user accounts if necessary.

To delete users:

Note: managing users can only be done when the Administrator is logged into the 
Administrator account. The menu items mentioned below do not appear when a user is 
logged into a normal user account.

1
.

Select User List from the File menu. The Users dialog box is 
displayed, showing the Administrator and currently configured
user accounts.

2
.

Select the user account you wish to delete, and then select 
the Delete button. The Confirm Delete dialog box is displayed.

3
.

Select the Yes button to delete the selected user account, or 
the No button to avoid doing so.

4
.

Repeat steps 2 and 3 for any additional user accounts you 
wish to delete.

5
.

When you are done deleting users, select the OK button in the
Users dialog box.

6
.

You are asked if you would like to send an updated list of 
users to all Message Center users. Select the Yes button to 
automatically generate the appropriate message, or the No 
button to avoid doing so.

Related topics:
Adding users
Modifying users
Sending User List 
File menu



Detaching attachments
Message Center allows you to send and receive messages which have attached files. These 
files can be either arbitrary PC files or ZAURUS Filer folders which contain ZAURUS 
application data.

To detach attachments:

PC files

1
.

With the message open in detail view, select the Detach 
button. The list of attached files is displayed in the 
Attachments dialog box. The list includes the file name, 
description, file type, and size of the file.

2
.

Select the file to detach, and select the Detach button. The 
Detach dialog box is displayed.

3
.

Modify the filename if desired, and select the destination 
drive and directory where you would like the file detached to. 
Select the OK button. A copy of the file is detached.

ZAURUS Filer folders

1
.

With the message open in detail view, select the Detach 
button. The list of attached files is displayed in the 
Attachments dialog box. The list includes the file name, 
description, file type, and size of the file.

2
.

Select the Filer folder to detach, and select the Export button. 
The Export ZAURUS Filer Folder dialog box is displayed, which 
lists the application data that is contained in the folder.

3
.

Select the ZAURUS application data you wish to export, and 
select the Export button. If the selected application data is 
from Appointments, To Do, Birthday/Anniversary, Holiday, 
Contacts or Data Files, selecting one entry of that type selects
all entries of that type, and they will all be exported together 
into one file. Documents, Outlines, or Notes entries are 
exported individually.

4
.

In the Export dialog box, the settings for file format, field 
maps, etc. are provided. See Export for more information.
When the settings are complete, select the OK button. The 
export process begins. When the export is done, you are 
returned to the ZAURUS Filer Folder dialog box.

5
.

Repeat steps 3 and 4 to export other data from the same Filer
folder.

Related topics:
The In Folder 
Viewing Filer folder attachments



Adding attachments
Deleting attachments



Detail View

Switches the current folder to Detail view, which displays the contents of the current 
message in the folder.

Related topics:
Index View



Dialing

Select the appropriate dialing type for the phone line being used for communication. If you 
wish to hear the modem tones when a connection is being established (when users are 
calling in), check the Modem Speaker On box. Otherwise, uncheck the box to avoid being 
distracted by the noise.



Edit menu
Click on the area of the menu you would like more information about:



Enable Quick Note

Select the Enable Quick Note check box to allow anyone to leave a message for a ZAURUS 
Mail user. If this option is not selected, the Send Quick Note button and text display will not 
be shown on the main screen.



Exit

Exits ZAURUS Mail. Users cannot send and receive messages if ZAURUS Mail is not running.



Export
Export allows you to detach ZAURUS Filer folder attachments to a PC file, storing the data in 
any of several standard PC file formats (e.g. .CSV, .SDF, .RTF, .TXT, .BMP, etc.), depending 
upon the application.

Step-by-step instructions

Click on the area of the window you would like more information about:



Export - Step-by-Step
Export allows you to detach ZAURUS Filer folder attachments to a PC file, storing the data in 
any of several standard PC file formats (e.g. .CSV, .SDF, .RTF, .TXT, .BMP, etc.).

To export Filer folder data:
      

1
.

In the Export dialog box, select the desired export file format in the 
Export File Format drop-down list. The possible options will vary 
depending upon which application entry type you selected in the 
Export ZAURUS Filer Folder dialog box (which is indicated in the title 
bar of the Export dialog box).

2
.

Select a field mapping in the Currently Selected Map drop-down list. 
Field mappings only apply for .CSV and .SDF file formats. The field 
map determines the order that the fields are exported in, as well as 
any combining or splitting of fields. If necessary, you can:

o
o
o

Create new field mappings
Modify existing field mappings
Delete existing field mappings

3
.

Select the First Record Contains Field Titles check box if necessary. 
This feature is only available for certain application types, and only 
applies when exporting to .CSV or .SDF file formats. Selecting this 
option causes the application field names to be exported as the first 
record in the export file.

4
.

Select the Format Options button to specify the date format and 
new-line translation. Format Options only apply when exporting 
to .CSV and .SDF file formats.

5
.

When you're finished making selections, select the Export button. 
The Export File Name dialog box is displayed.

6
.

Enter a filename for the export file in the File Name box. If you would
like to overwrite an existing file, select it in the Files list.
In the Drives list, select the drive where you would like the export file
saved.
In the Directories list, select the directory where you would like the 
export file saved.

7
.

When you're finished, select the OK button. The export process will 
begin, and a progress dialog will be displayed.

Related topics
Selecting the application to be exported.
Selecting the export file format.
Creating a field map for the application to be exported.
Modifying a field map for the application to be exported.
Deleting a field map.
Selecting the export data source.
Specifying format options.



Export File Formats
The following export file formats can be selected in the Export File Format box of the Export 
dialog box. The availability of a specific file format depends on the selected application.

ZAURUS Data Format (.ZDF)
A special ZAURUS file format. This is best used when the data will be imported back into a 
ZAURUS.

Comma Separated Values (.CSV)
A file format which encloses each field with double quotes ("), divides each field in the 
record with a comma (,), and ends each record with a carriage return/line feed.

Standard Delimited Format (.SDF)
A file format similar to .CSV, but which is supported and defined by Borland's dBase 
database.

Plain Text Format (.TXT)
Plain ASCII text format. Nearly any word processor or editor can read and write this format.

Rich Text Format (.RTF)
A file format defined by Microsoft that maintains the formatting and general appearance of a
document (bold facing, underlining, etc.).

Windows Bitmap Format (.BMP)
A common graphic file format supported by most graphics programs, including Windows 
Paintbrush.



Field Mapping

The Field Mapping capability allows you to tailor the import and export field layouts when 
either the .CSV or .SDF file formats have been selected. This provides the ability to match 
the data format requirements of other applications with which you may want to exchange 
data. You may reorder, combine, split, or ignore fields as necessary.



File menu
Click on the area of the menu you would like more information about:



First Record Contains Field Titles (Export)

If you wish to include the field titles of the application you are exporting as the first record in
the export file, select the First Record Contains Field Titles check box. This feature is only 
available for certain applications, and only applies when exporting to .CSV or .SDF file 
formats.



First Record Contains Field Titles (Import)

If the first record of the file you are importing contains field titles, and you do not want them 
imported as an application entry, select the First Record Contains Field Titles check box. The 
first record of the import file will be ignored during the import process. This feature is only 
available for certain applications, and only applies when importing from .CSV or .SDF file 
formats.



Format options
When exporting ZAURUS Filer folder application data to either .CSV or .SDF file formats, you 
can specify two Format Options; the Date Format, and the New-Line Translation.

To specify Format Options:

1
.

Select the Format Options button in the Export dialog box. The 
Format Options dialog box is displayed.

2
.

In the Date Format box, select the desired date format. When an 
exported application's data contains a date field and you are 
exporting to a file format of CSV or SDF, the date field is converted to
the selected format. This allows you to match the date field 
requirements for another application which will read the exported 
file.
The following date formats may be selected:

Format
MM/DD/YY
DD.MM.YYYY
YYYYMMDD

Example
12/25/95
25.12.1995
19951225

3
.

In the New-Line Translation box, select the character that you want 
used at. the end of lines This allows you to match the new-line (end-
of-line) requirements for another application which will read the 
exported file.
The following new-line characters may be selected:

Vertical Tab (VT)
Horizontal Tab (HT)
Carriage Return (CR)
Line Feed (LF)
Space

4
.

When you are finished, select the OK button to save the settings.

Related topics
Export
Export file formats



Forward

Forwards the current message to another ZAURUS Mail user. A new message creation form is
opened, with the contents of the original message automatically inserted in the new 
message.

Related topics:
Forwarding a message



Forward messages to pager

Check the Forward messages to Pager box if you would like to selectively forward messages 
to an alphanumeric pager. This check box is only available if the Administrator has 
configured your ZAURUS Mail account for a pager service. Selecting the Filter button allows 
you to configure the message forwarding filter.



Forwarding a message
Message Center provides the ability to forward a message you have received from another 
user.

To forward a received message:

1
.

Select the message you wish to forward in the In Folder, and select 
Forward from the Message menu. The message creation screen is 
displayed, with the subject of the original message filled in for you, 
and the original message body inserted in the new message body.

2
.

The remainder of the process is the same as when creating a new 
message.

Related topics:
Accessing your mailbox
Adding attachments 
Addressing a message 
Sending a message 
The Out Folder 
Creating a new message 
Answering a message 
Message menu



Help menu
Click on the area of the menu you would like more information about:



How to Use Help

Displays the on-line help for how to use the standard Windows Help "engine" which is used 
to display the ZAURUS Mail on-line help.



IR/Cable COM Port

Select the COM port to which your IR unit or cable is attached. If you will not be using IR or 
cable communications, set the COM Port to None.



IR/Cable type

Select the appropriate connection method that you are using; Cable, CE-IR2 (wireless 
infrared), or CE-IR4 (IrDA compatible wireless infrared).



Import
Import allows you to import PC files into ZAURUS Filer folder attachments. Several standard 
PC file formats (e.g. .CSV, .SDF, .RTF, .TXT, etc.) are supported, depending upon the selected
ZAURUS application.

Step-by-step instructions

Click on the area of the window you would like more information about:



Import - Step-by-step
Import allows you to import PC files into ZAURUS Filer folder attachments. Several standard 
PC file formats (e.g. .CSV, .SDF, .RTF, .TXT, etc.) are supported, depending upon the selected
ZAURUS application.

To import data:
      

1
.

In the Import dialog box, select the ZAURUS application data type 
you wish to import into the Filer folder from the Into Application drop-
down list.

2
.

Select the import file format in the Import File Format drop-down list.

3
.

Enter the import file name in the File Name field, or select the 
Browse button, and select the import file name.

4
.

Select a field mapping you may have previously created in the 
Currently Selected Map drop-down list. Field mappings only apply 
for .CSV and .SDF file formats. You can also:

o
o
o

Create new field mappings,
Modify existing field mappings, or
Delete existing field mappings.

5
.

Select the First Record Contains Field Titles check box if desired. This 
feature is only available for certain applications, and only applies 
when importing from .CSV or .SDF file formats.

6
.

Optionally, select the Preview button to view the contents of the 
import file. The Import Preview dialog box is displayed. Select the 
Close button to return to the Import dialog box. 

7
.

When you're finished, select the Import button. The import process 
will begin, and a progress dialog box will be displayed.

Related topics
Selecting the application to be imported to. 
Creating import field maps
Modifying import field maps
Deleting import field maps



Import Preview

Select the Preview button to view the contents of the file you have selected to import. This 
can be helpful when you are not sure about the contents or format of the selected file. Only 
a text view of the data is provided, so Preview is useful mainly for viewing .CSV, .SDF, 
and .TXT files that you are about to import.



Import file formats
The following import file formats can be selected in the Import File Format box of the Import 
dialog box. Note that the availability of a specific file format depends on the selected 
application.

ZAURUS Data Format (.ZDF)
A special ZAURUS file format produced by ZAURUS Message Center and ZAURUS Data 
Exchange Utility.

Comma Separated Values (.CSV)
A file format which encloses each field with double quotes ("), divides each field in the 
record with a comma (,), and ends each record with a carriage return and line feed.

Standard Delimited Format (.SDF)
A file format similar to .CSV, but which is supported and defined by Borland's dBase 
database.

Plain Text Format (.TXT)
Plain ASCII text format. Nearly any word processor or editor can read and write this format.

Rich Text Format (.RTF)
A file format defined by Microsoft that maintains the general formatting and appearance of a
document (bold facing, underlining, etc.).



Import File Name

Enter the file name of the file you wish to import into a ZAURUS Filer folder attachment. You 
may also use the Browse button to find the desired file.



Import into application
The following ZAURUS application data types can be selected for importing to in the Into 
Application box of the Import dialog box:

Application Supported Import File Formats
Appointments Comma separated values (.CSV), Standard delimited 

format (.SDF), ZAURUS data format (.ZDF)

To Do Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Birthday/
Anniversary

Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Holiday by Date Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Holiday by Day Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Contact1 Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Contact2 Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Contact3 Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Data File 1 Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Data File 2 Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Data File 3 Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Notes ZAURUS data format (.ZDF)

Documents Text (.TXT), Rich text format (.RTF), ZAURUS data 
format (.ZDF)

Outlines Text (.TXT), ZAURUS data format (.ZDF)

      
Note: For Documents, Outlines, and Notes, each file is imported as one 

application data entry.



In the date range

Selecting In the date range in the Print Range group will cause all messages within the 
selected date range in the selected folders to be printed.



Index View

Switches the current folder to Index view, which displays a summary listing of the messages 
in the folder.

Related topics:
Detail View



Initialization

If your modem requires a special initialization string, enter it here. Message Center's default 
initialization string will work with most Hayes-compatible modems. Selecting the Default 
button will reset the string to its factory default.



Lock PC

Select the Lock PC check box to disable use of the PC by someone else while you are away. 
Note that the Quick Note feature is still available even when the PC is locked.



Menus

Click on the sub menu you would like more information about:



Message Server

Allows you to enable or disable the Quick Note feature, as well as lock the ZAURUS Mail PC 
while you are away (Quick Note still functions, if enabled). This menu item only appears 
when the Administrator is logged in.

Related topics:
Message Server setup



Message Server setup
The Message Center Administrator can enable or disable two Message Server options:

Enable Quick Note
Quick Note is a feature that allows anyone to send a message to a Message center user, 
even if they are not a Message Center user themselves. Enabling this feature causes a Send 
Quick Note button to appear on the Message Center main screen, which provides access to a
simplified message creation dialog box. An optional Quick Note message can be displayed to
the left of the Quick Note button.

Lock PC
The Lock PC feature allows you make your PC more secure while you are away and it is 
waiting for Message Center users to call in. When the Lock is enabled, all functions except 
Quick Note are disabled. 

Step-by-step instructions

Click on the area of the window you would like more information about:

Related topics:
Options menu



Message Server setup - step-by-step
To set Message Server options:

Note: setting the Message Server options can only be done when the Administrator is logged
into the Administrator account. The menu items mentioned below do not appear when a 
user is logged into a normal user account.

1
.

Select Message Server from the Options menu. The Message 
Server dialog box is displayed.

2
.

Select the Enable Quick Note and/or Lock PC check boxes as 
desired. If you enable Quick Note, you may optionally enter 
some text to display to the left of the Quick Note button.

3
.

Select the OK button when you have completed the settings.

        

Related topics:
Quick Notes 



Message menu
Click on the area of the menu you would like more information about:



Modifying Export Field Mappings
Existing export field mappings can be modified as necessary.

To modify export field mappings:

Not
e:

the accessibility of specific export field mappings depends upon the 
currently selected application and export file format.

1
.

In the Export dialog box, select the field map which you wish to modify 
from the Currently Selected Map drop-down list in the Field Mapping box.

2
.

Select the Modify button in the Field Mapping box. The Modify Mapping 
dialog box is displayed.

3
.

Source File fields can be divided into 1-4 fields using the Split Field 
function. The divided fields can then be mapped individually to the 
Destination File. You must clear all field mappings before you can split a 
field.

4
.

If the Destination File requires fewer or more fields than the default 
number, it can be changed in the Number of Export Fields box. Simply 
use the arrows to increment or decrement the current value (you can 
specify between 1 and 32 fields).

5
.

Select each field in the Source File list, and copy it to the desired 
Destination File field. This can be done in two ways:

o After selecting the field in the Source File list, select the field to move
it to in the Destination File list, and then select the Add> button. The 
field from the Source File list is shown in the Destination File list. 

You may copy multiple fields from the Source File list to the same 
field in the Destination File. Simply continue selecting fields in the 
Source File and select the Add> button without changing the 
Destination File field selection (a maximum of 4 Source File fields can
be mapped to the same Destination File field). The currently selected
Separator character will be inserted between fields automatically. 
The Separator can be changed using the Change Separator drop-
down list. The available separators are:

*
*
*
*
*
*

*

[,] - Comma
[SP] - Space
[CR] - Carriage Return
[NO] - No Separation
[/] - Slash
[+] - Start Time+Duration
Add the Start Time to the Duration to get the End Time.
Note: The Duration is shown in minutes.
[-] - End Time-Start Time
Subtract the End Time from the Start Time to get the Duration.

o Select the Map All> button to copy all of the Source File fields to the 
Destination File automatically. Each Source File field is copied to the 



corresponding Destination File field.

6
.

If necessary, you can remove fields from the Destination File list. To 
remove a field, do the following:

o

o

Select the desired field in the Destination File list, and then select the
Remove button.
Or
Select the Clear All button to remove all fields from the Destination 
File list.

7
.

When you're finished, select the OK button.



Modifying Import Field Mappings
Existing import field mappings can be modified as necessary.

To modify import field mappings:

Not
e:

the accessibility of specific import field mappings depends upon the 
currently selected application and the import file format.

1
.

In the Import dialog box, select the field map which you wish to modify 
from the Currently Selected Map drop-down list in the Field Mapping box.

2
.

Select the Modify button in the Field Mapping box. The Modify Mapping 
dialog box is displayed.

3
.

Source File fields can be divided into 1-4 fields using the Split Field 
function. The divided fields can then be mapped individually to the 
Destination File. You must clear all field mappings before you can split a 
field.

4
.

The first record of the data to be imported is shown next to each field in 
the Source File field list. To view other records:

o
o

Select the Prev button to display the previous record.
Select the Next button to display the next record.

5
.

Select each field in the Source File list, and copy it to the desired 
Destination File field. This can be done in two ways:

o After selecting the field in the Source File list, select the field to move
it to in the Destination File list, and then select the Add> button. The 
field from the Source File list is shown in the Destination File list. 

You may copy multiple fields from the Source File list to the same 
field in the Destination File. Simply continue selecting fields in the 
Source File and select the Add> button without changing the 
Destination File field selection (a maximum of 4 Source File fields can
be mapped to the same Destination File field). The currently selected
Separator character will be inserted between fields automatically. 
The Separator can be changed using the Change Separator drop-
down list. The available separators are:

*
*
*
*
*
*

*

[,] - Comma
[SP] - Space
[CR] - Carriage Return
[NO] - No Separation
[/] - Slash
[+] - Start Time+Duration
Add the Start Time to the Duration to get the End Time.
Note: The Duration is shown in minutes.
[-] - End Time-Start Time
Subtract the End Time from the Start Time to get the Duration.

o Select the Map All> button to copy all of the Source File fields to the 



Destination File automatically. Each Source File field is copied to the 
corresponding Destination File field.

6
.

If necessary, you can remove fields from the Destination File list. To 
remove a field, do the following:

o

o

Select the desired field in the Destination File list, and then select the
Remove button.
Or
Select the Clear All button to remove all fields from the Destination 
File list.

7
.

When you're finished, select the OK button to save the changes.



Modifying users
The Message Center Administrator can modify user account configurations if necessary.

To modify users:

Note: managing users can only be done when the Administrator is logged into the 
Administrator account. The menu items mentioned below do not appear when a user is 
logged into a normal user account.

1
.

Select User List from the File menu. The Users dialog box is 
displayed, showing the Administrator and currently configured
user accounts.

2
.

Select the user account you wish to modify, and then select 
the Modify button. The Modify User dialog box is displayed.

3
.

The user's Name, User ID, Pager Service, and pager PIN may 
be modified as necessary. See Adding users for information 
about each of these items.

Select the OK button when you are done. Name and/or User 
ID modifications are reflected in the Users list.

4
.

Repeat steps 2 and 3 for any additional user accounts you 
wish to modify.

5
.

When you are done modifying users, select the OK button in 
the Users dialog box.

6
.

If you modified any Names or User IDs, you are then asked if 
you would like to send an updated list of users to all Message 
Center users. Select the Yes button to automatically generate 
the appropriate message, or the No button to avoid doing so.

Related topics:
Adding users
Deleting users
Sending User List 
File menu



New

Opens a new message creation form.

Related topics:
Creating a new message



New password

Enter the new password you wish to use here.



Old password

To change your password, enter your old (current) password here.



Open Mailbox

Opens the mailbox which is currently highlighted in the main window.

Related topics:
Accessing your mailbox



Options menu
Click on the area of the menu you would like more information about:



Pager Service Setup

Allows you to configure up to 4 pager services which ZAURUS Mail users may subscribe to, 
and through which they may selectively forward their messages to their alphanumeric pager.
This menu item only appears when the Administrator is logged in.

Related topics:
Pager Service setup (detailed)



Pager Service setup
Message Center has a feature which allows users to selectively forward messages to their 
pager. However, before they can do so, the Message Center Administrator must configure 
the paging service, and then register users to use the appropriate service. Up to four 
different paging services can be setup.

Step-by-step instructions

Click on the area of the window you would like more information about:

Related topics:
Options menu



Pager filter
When properly pre-configured by the Message Center Administrator, users can configure 
their mailbox to forward selected messages to a pager. The Pager filter feature allows each 
user to specify their own criteria for which of their received messages are forwarded to their 
pager.

To enable message forwarding and configure the Pager filter:

1
.

Select Preferences from the Options menu. The Preferences 
dialog box is displayed.

2
.

Select the Forward messages to Pager check box in the Pager 
group. The Filter button becomes available.

3
.

Select the Filter button. The Pager Filter dialog box is 
displayed.

4
.

To filter messages by the content of the From or Subject field, 
select the Include if check box, select the From: or Subject: 
field from the drop-down list, and enter the text to search for 
in the Contains field.

5
.

To forward only high priority messages, select the High 
priority only check box. Note that this may be combined with 
the options in step 4 above.

6
.

In the Content Option group, select what part of messages 
you wish to have forwarded:

Send message 
headers only:

Send message 
header and body up
to first [ ] 
characters:

Only the originator, recipient, date, time, 
and subject information are sent to the 
pager. This can be used for simple 
notification of waiting mail.

Sends the same information as the 
header-only option, plus part (potentially 
all) of the message text, up to a user-
specified character count limit.

If you select the second option, set the maximum message 
character count to the desired size. The absolute maximum 
size is set by the Administrator, and is dependent upon your 
paging carrier.

7
.

When the settings are complete, select the OK button. Then 
select the OK button in the Preferences dialog box to return to
the main folder view.

Related topics:
Preferences setup



Pager service max length

This is the maximum length of a message which you can send to a pager through the 
particular service. Your pager service must provide you with this number. ZAURUS Message 
Center supports up to 240 characters.



Pager service name

Enter the name of your pager service(s) here. The names you enter here will appear in the 
Pager service list when you add or modify user accounts.



Pager service phone number

The pager service phone number is the modem access number for the particular pager 
service. When you request this number from your paging service, they may refer to it as the 
"TAP access number".



Pager service setup - step-by-step
To setup pager services:

1
.

Select Pager Service Setup from the Options menu. The Pager
Service Setup dialog box is displayed.

2
.

For each paging service you wish to setup, enter the following
information:

Name:
Phone 
number:

Max Length:

Enter the name of the pager service.
Enter the phone number of the pager service. 
This is the phone number for sending pager 
messages via modem.
Enter the maximum message length supported 
by the pager service.

When your settings are complete, select the OK button. You 
return to the folder views.

Related topics:
Pager Service setup
Preferences setup
Pager filter



Paste

Pastes the contents of the Windows clipboard at the current text cursor position.



Preferences

Allows you to change your password, enable and configure automatic message deletion, and
enable and configure selective message forwarding to an alphanumeric pager.

Related topics:
Preferences setup



Preferences setup
Preferences setup allows Message Center users to change their password, set a message 
expiration period, and configure message forwarding to a pager (if the Administrator has 
setup pager services, and enabled pager forwarding support for the user).

Step-by-step instructions

Click on the area of the window you would like more information about:

Related topics:
Options menu



Preferences setup - step-by-step
To setup your preferences:

1
.

Select Preferences from the Options menu. The Preferences 
dialog box is displayed.

2
.

If you wish to change your password, enter the following 
information in the Change Password group:

Old Password:
New Password:
Retype New 
Password:

Enter your current password.
Enter the new password you wish to use.
Enter the new password again.

3
.

If you wish to enable automatic message deletion after a 
specified period, select the Delete messages after check box 
in the Delete Messages group, and set the period in the days 
field (up to 99 days).

4
.

If you wish to selectively forward your messages to a pager, 
select the Forward messages to Pager check box in the Pager 
group. See Pager filter for information on how to establish 
your message forwarding criteria.

5
.

When you are done setting up your preferences, select the OK
button to return to the main screen.

Note: each of the mail folders (In, Out, Sent) has a capacity of 5000 messages. If that 
capacity is reached, as each message over the limit arrives, the oldest message is 
automatically deleted.

Related topics:
Preferences setup
Pager Filter 



Print

Allows you to print selected (all, currently selected, or those in a date range) messages from 
any of the mail folders.

Related topics:
Printing



Print Setup
Print Setup allows you to select the current printer, as well as configure various printer 
settings and options. You can select the paper orientation (portrait and landscape), paper 
size and source, and other printer-specific options by selecting the Options button.

Related topics:
Printing
File menu



Print Setup

Allows you to select and configure the printer you wish to print messages on.

Related topics:
Print Setup (step-by-step)



Print all messages

Selecting Print all messages in the Print Range group of the Print dialog box will cause all 
messages in the selected folders to be printed.

Related topics:
Printing



Print formats
When you print messages, the following information and formats are used:

In Folder messages:

In Folder
      

Date/Time: [Date]    
[Time]

 

To: [To: recipients]
From: [Originator]
Cc: [Cc: recipients]
Subject: [Subject]
Message: [Message 

contents]

Out Folder messages:

Out Folder

Date/Time: [Date]    [Time]
To: [To: recipients]
Cc: [Cc: recipients]
Bcc: [Bcc: recipients]
Subject: [Subject]
Message: [Message contents]

Sent Folder messages:

Sent Folder

Date/Time: [Date]    
[Time]

 

To: [To: recipients]
Cc: [Cc: recipients]
Bcc: [Bcc: recipients]
Subject: [Subject]
Message: [Message 

contents]

Related topics:
Printing



Print selected messages

Selecting Print selected messages in the Print Range group of the Print dialog box will cause 
the currently selected messages in the currently open folder to be printed. If you have 
selected other folders in addition to or in place of the currently open folder, they will be 
deselected and grayed, and the currently open folder will be automatically selected.



Printing
You may print all messages, selected messages (current folder only), or messages within a 
date range, from any combination of the In, Out, or Sent folders (except as noted for 
selected messages).

To print messages:

1
.

Select Print from the File menu. The Print dialog box is displayed, 
showing the currently selected printer. If you wish to use a different 
printer, select the cancel button and then select Print Setup from the
File menu.

2
.

Select the folder(s) of messages you wish to print by checking the In,
Out, and/or Sent check boxes in the Folder group on the left.

3
.

Select the desired set of messages within the selected folders to 
print using the options in the Print Range group; Print all messages, 
Print selected messages, or In the date range. If you select Print 
selected messages, folders other than the currently open one will be 
deselected and grayed.

4
.

If you selected In the date range in step 3, adjust the From and To 
dates as desired. You may edit the month, day, and year fields 
directly, or select a field and use the arrow buttons to increment or 
decrement the value.

5
.

If you wish to change the settings for the current printer, select the 
Setup button, make any changes in the dialog box that is displayed, 
and select the OK button.

6
.

Select the OK button to begin printing.

Related topics:
Print formats
Print setup
File menu



Quick Note Message Text

If you enable Quick Notes, the Quick Note message text you specify here will be shown on 
the main screen.



Quick notes
Quick Note is a feature that allows anyone to send a message to a Message center user, 
even if they are not a Message Center user themselves. If this feature is enabled by the 
Administrator, a Send Quick Note button appears on the Message Center main screen, which
provides access to a simplified message creation dialog box.

To send a Quick Note:

1
.

Select the Quick Note button on the main screen to display 
the Quick Note dialog box.

2
.

To create a Quick Note, complete these items:

From:
To:
Subject:
Priority:
Note:

Enter your name.
Select the name of the recipient from the drop-down 
list.
Enter a brief subject for the message.
Select the message priority from the drop-down list.
Enter the contents of the message.

3
.

When you have completed the message, select the Send 
button to send it.

Related topics:
Message Server setup 



Re-type new password

Re-type your new password here. This is done to make sure you didn't mistype the password
in the New Password box.



Reading a message
Any message in the In, Out, or Sent folder may be shown in Detail view for reading.

To read a message:

a
.

Select the desired message in the folder Index view, and 
select Detail View from the View menu.

OR

b
.

Select the desired message in the folder Index view, and 
press the Enter key.

OR

c
.

Select the desired message in the folder Index view, and 
select Detail tool bar button.

OR

d
.

Double-click on the message in the folder Index view.

Related topics:
The In Folder 
Detaching attachments
Printing
Answering a message
Forwarding a message
View menu



Receiving Mail (on the PC)

The following topics are available:

The In Folder 
View Filter 
Reading a message 
Detaching an Attachment 
Saving received messages 
Searching messages 



Receiving messages (on ZAURUS)
While away from the office, you can use your ZAURUS to send and receive messages from 
Message Center by using a modem, such as the SHARP CE-FM4. While in the office, you can 
use also use your ZAURUS to send and receive messages using an infrared wireless interface
(such as SHARP CE-IR4) or a ZAURUS-compatible cable (such as the Aegis cable offered on 
the ZAURUS registration card).

To receive messages on your ZAURUS:

1
.

Touch TOOLS, and touch Message under Utilities twice. The 
Message application is displayed.

2
.

Touch MAIL, and then select Receive Only. If you wish to 
selectively download messages, make sure Turn On Receive 
Filter is selected under MAIL before you select Receive Only. If
you do not enable the Receive Filter, skip to step 4.

3
.

Specify the message filtering criteria. Your options are:

Field:, Contains:

Exclude if return 
receipt requested

Size must be less than 
[ ] chars.

Include old messages

Preview summaries 
before receiving

Receive messages which contain the 
specified text in the selected 
message field (Subject, User Name or 
User ID).
Touch this check box to exclude 
messages where the originator has 
requested a receipt indicating when 
you received the message.
Touch this check box and select a 
maximum message size to limit the 
size of individual messages that you 
receive.
Touch this check box to include 
messages you have already received 
in the past.
Touch this check box to preview the 
list of messages which match the 
Receive Filter criteria you have 
specified. You may then selectively 
download messages from the list. This
provides the ultimate in control over 
messages you receive.

Touch OK when you are done with your Receive Filter settings.

4
.

In the Connect to Host screen, touch the desired connection 
method (Cable or Wireless if you are physically near the PC 
running ZAURUS Message Center, or Modem if you are dialing
in remotely), and touch OK. If you are using a modem, you 
may check the Host and Modem setups by touching Setup. 
The Connect to Host progress screen is displayed, and your 
ZAURUS attempts to access and log into Message Center. If 
you did not enable the preview feature in step 2, skip to step 
6.



5
.

Once your ZAURUS has logged into Message Center, a list of 
messages matching your receive filter criteria will appear. You
may receive the:

Currently selected 
message:
Multiple (tagged) 
messages:
All messages:

Simply select the message.

Touch the check box to the left of 
each message you wish to receive.
Do nothing.

When you are done selecting messages, touch RECV, make 
the appropriate selection, and touch OK.

6
.

The receiving of messages is started. Pressing the ON button 
cancels the receiving of messages.

Related topics:
Communicating   via IR/Cable  
Sending a message (on ZAURUS) 
Sending a message (on the PC) 



Save As

Allows you to save the contents of messages to a text file.

Related topics:
Saving messages



Saving messages
Message Center allows you to save messages into plain text files. Depending upon the 
specific message folder, the file will include the date, time, originator, recipients, subject, 
and the message text.

To save a message:

1
.

Select the messages you wish to save (there is no need to 
select any if you wish to save all of them), and then select 
Save As from the File menu. The Save Message As Text dialog 
box is displayed.

2
.

Specify the following items:

Selected Messages:

All Messages:

Delete messages 
after saving:

Select this option to save the currently 
selected messages.
Select this option to save all messages 
in the current folders.
Select this check box (in combination 
with either of the other two options) to 
have message deleted after they are 
saved to a text file.

When you have completed your selections, select the OK 
button. The Save as dialog box is displayed.

3
.

Select or specify a file name, directory, and drive, and select 
the OK button. The message(s) are saved as a text file.

Related topics:
File menu



Search

Allows you to search for a particular message in any of the folders based on a keyword.

Related topics:
Searching for messages



Search for Help on

Allows you to search the on-line help for a specific topic.



Searching for messages
Message Center allows you to search for messages in selected folders. The Search function 
looks for the specified text in both the message subject and body.

To search for a message:

1
.

Select Search from the File menu.

2
.

Enter the word or phrase to search for in the Find box. The 
search is case-insensitive and can be up to 16 characters 
long.

3
.

Select the desired folders to search. Any combination of the 
In, Out, and Sent folders may be selected.

4
.

Select the Prev or Next button to start searching. When a 
matching message is found, it is displayed in Detail view. 
Once a message is found, you may select the Prev button to 
display the previous matching message, or select the Next 
button to display next matching message.

5
.

When the desired message is displayed, select the Close 
button to close the Search dialog box.

Related topics:
The Out Folder 
The In Folder 
The Sent Folder 
View Filter 
File menu



Select All

Selects all of the messages in the current folder.



Selecting an import file
To select an import file:

1
.

Selecting the Browse button in the Import dialog box displays the 
Import File Name dialog box.

2
.

Select the drive where the Import file is located from the Drives drop-
down list.

3
.

Select the directory where the Import file is located from the 
Directories list.

4
.

Select the file extension for the Import file from the List Files of Type 
drop-down list.

5
.

Select the desired Import file from the Files list. The file name will be 
displayed in the File Name box.

6
.

Select the OK button.

Related topics
Import



Send

Sends any messages you have created but haven't yet sent. These are the messages in your
Out folder.

Related topics:
Sending messages



Send User List

Broadcasts the current list of users and their User IDs in a message to all users. This menu 
item only appears when the Administrator is logged in.

Related topics:
Sending the User List



Creating and Sending Mail (on the PC)

The following topics are available:

The Out Folder 
Creating a new message 
Answering a message 
Forwarding a message 
Addressing a message 
Adding attachments 
Sending a message 
Quick notes 
The Sent Folder 
Creating a Send List 
Sending User List
Searching messages 
Deleting messages 



Sending messages (on ZAURUS)
When messages are created on your ZAURUS, they accumulate in the Out folder until you 
send them.

To send messages from your ZAURUS:

1
.

Touch the Out folder tab if the Out folder isn't already open.

2
.

If you are in Index view, and wish to only send certain 
messages, select the messages you wish to send by touching 
the check box to the left of each message.

3
.

Touch MAIL and select Send Only. The Send Mail screen is 
displayed.

4
.

You may send the Current Message, Tagged (selected) 
Messages, or All Messages. Touch the desired option, and 
then touch OK. The Connect to Host screen is displayed.

5
.

In the Connect to Host screen, touch the desired connection 
method (Cable or Wireless if you are physically near the PC 
running ZAURUS Message Center, or Modem if you are dialing
in remotely), and touch OK. If you are using a modem, you 
may check the Host and Modem setups by touching Setup. 
The Connect to Host progress screen is displayed, and your 
ZAURUS attempts to access and log into Message Center.

6
.

Once logged in, the message(s) are sent.

Related topics:
Communicating   via IR/Cable   
Receiving messages   (on ZAURUS)  
Sending messages (on the PC) 



Sending messages (on the PC)
When messages are created, they accumulate in the Out folder until you send them.

To send messages:

1
.

Select the Out folder if it isn't already selected.

2
.

If you are in Index view, and wish to only send certain 
messages, select the messages you wish to send.

3
.

Select Send from the Message menu, or click on the Send tool
bar button. The Send dialog box is displayed.

4
.

If you are in Index view, you may send all messages or only 
the currently selected messages. If you are in Detail view, you
may send all messages, or the currently displayed message. 
Select the desired option, and then select the OK button.

5
.

The message(s) are sent.

Related topics:
Creating a new message 
Answering a message 
Forwarding a message 
The Out Folder 
Addressing a message 
Adding attachments 
Message menu



Sending the User List
When users are added or deleted, or an existing user's Name or User ID are changed, 
Message Center users need to be advised of the changes. Message Center provides a 
feature which the Administrator can use to broadcast an updated user list to all Message 
Center users.

To broadcast the user list:

Note: managing users can only be done when the Administrator is logged into the 
Administrator account. The menu items mentioned below do not appear when a user is 
logged into a normal user account.

1
.

Select Send User List from the File menu.

2
.

The Send dialog box is displayed, and select the OK button.

3
.

The broadcast message is automatically sent.

        

Related topics:
Adding users
Modifying users
Deleting users
File menu



Splitting Fields
When creating a new field map for importing or exporting of data to or from a ZAURUS Filer 
folder attachment, there are instances where it is desirable to split the data of a Source File 
field into two or more (up to 4) parts so they may be mapped individually to Destination File 
fields.

For example, a person's first name and last name may be in the same field in the Source 
File, but you may want to put them into separate fields in the Destination File.

To split a field:

1
.

Select the field to be split in the Source File list, and then select the 
Split Field button. The Split Field dialog box is displayed.

2
.

Enter the number of parts (1 to 4) you want in the Split Field into 
box.

3
.

Select the appropriate Separating Character box(es). The separating 
character determines where the field data will be split during an 
Import or Export. Note that you may select more than one separating
character, if necessary.
You can select among:

o
o
o
o

[,] - Comma
[SP] - Space
[CR] - Carriage Return
[/] - Slash

4
.

Select the OK button to split the field.



The In Folder
When you access your Message Center mailbox, you are initially presented with the In folder
Index view. The In folder contains messages you have received. To access the In folder when 
viewing other folders, select Folder/In from the View menu, or click on the In folder tab. You 
may switch between Index and Detail view by selecting the desired mode from the View 
menu, or clicking on the appropriate tool bar buttons.

The In folder Index view displays the following information:

Unopened/Opened/Priority/Attachments
One of the following icons are shown in the left column to indicate the unopened/opened 
status of the message, the message's priority, and whether or not the message has any 
attachments:

Unopened, no attachments.
Opened, no attachments.
Unopened with attachment(s).
Opened with attachment(s).
Is combined with the message icons above to indicate 
high priority.
Is combined with the message icons above to indicate 
low priority.

Message Originator
Shows the sender of the message.

Subject
Shows the subject of the message.

Size
Shows the total size of the message, including attachments.

Date
Shows the date the message was received.

The In folder Detail view displays the following information:

Date and Time
Shows the date and time the message was received.

Priority
Shows the message priority; High, Normal, or Low.

Message Originator
The From field shows the sender of the message.

Message Recipients
The To and Cc fields show the recipients of the message. Note that Bcc recipients are of 
course not shown.

Subject
Shows the subject of the message.



Message Contents
The contents of the message are shown in the Message box.

Attachment Count
The number of attached files are shown in the Attachments field.

Return Receipt
The Return Receipt field indicates whether or not the message originator requested a receipt
be sent when you receive the message.

Detach Button
If the Attachments field indicates there are message attachments, you may use the Detach 
button to detach them.

Related topics:
Accessing your mailbox
Answering a message 
Forwarding a message 
Detaching attachments 
Reading a message
Printing
Print formats
View menu



The Out Folder
The Out folder contains messages you have created but not yet sent. To access the Out 
folder when viewing other folders, select Folder/Out from the View menu, or click on the Out 
folder tab. You may switch between Index and Detail view by selecting the desired mode 
from the View menu, or clicking on the appropriate tool bar buttons.

The Out folder Index view displays the following information:

Priority/Attachments
One of the following icons are shown in the left column to indicate the message's priority, 
and whether or not the message has any attachments:

Note: messages in the Out folder are always shown as unopened. 

Unopened, no attachments.
Unopened, with attachment(s).
Is combined with the message icons above to indicate 
high priority.
Is combined with the message icons above to indicate 
low priority.

First Recipient
Shows the first recipient you specified for the message.

Subject
Shows the subject of the message.

Size
Shows the total size of the message, including attachments.

Date
Shows the date the message was created.

The Out folder Detail view displays the following information:

Date and Time
Shows the date and time the message was modified if you are modifying a previously 
created message, or only the date if you are creating the message for the first time.

Priority
Shows the current message priority; High, Normal, or Low.

Message Recipients
The To, Cc, and Bcc fields show the recipients you have specified for the message.

Subject
Shows the subject of the message.

Message Contents
The contents of the message are shown in the Message box.

Attachment Count
The number of attached files are shown in the Attachments field.



Return Receipt
The Return Receipt check box indicates whether or not you are requesting a receipt be sent 
when the recipients receive the message.

Save sent Message
The Save sent Message check box indicates whether you want the message saved in the 
Sent folder after it has been sent.

Attach Button
You may use the Attach button to attach files to the message.

Related topics:
Accessing your mailbox
Creating a new message 
Answering a message 
Forwarding a message 
Addressing a message 
Adding attachments 
Sending a message 
View menu



The Sent Folder
The Sent folder contains messages you have created and sent. To access the Sent folder 
when viewing other folders, select Folder/Sent from the View menu, or click on the Sent 
folder tab. You may switch between Index and Detail view by selecting the desired mode 
from the View menu, or clicking on the appropriate tool bar buttons.

The Sent folder Index view displays the following information:

Priority/Attachments
One of the following icons are shown in the left column to indicate the unopened/opened 
status of the message, the message's priority, and whether or not the message has any 
attachments:

      

Unopened, no attachments.
Unopened, with attachment(s).
Is combined with the message icons above to indicate 
high priority.
Is combined with the message icons above to indicate 
low priority.

First Recipient
Shows the first recipient you specified for the message.

Subject
Shows the subject of the message.

Size
Shows the total size of the message, including attachments.

Date
Shows the date the message was sent.

The Sent folder Detail view displays the following information:

Date and Time
Shows the date and time the message was sent.

Priority
Shows the message priority; High, Normal, or Low.

Message Recipients
The To, Cc, and Bcc fields show the recipients you have specified for the message.

Subject
Shows the subject of the message.

Message Contents
The contents of the message are shown in the Message box.

Attachment Count
The number of attached files are shown in the Attachments field.



Return Receipt
The Return Receipt field indicates whether or not you requested a receipt be sent when the 
recipients receive the message.

Copy to OUT Folder Button
You may use the Copy to OUT Folder button to copy the sent message to the Out folder so 
that you can modify and resend it.

Attach Button
You may use the Attach button to view the files that are attached to the message.

Related topics:
Accessing your mailbox
The Out Folder 
Creating a new message 
Sending a message 
View menu



Undo

When available, undoes the last editing operation.



User List

Accesses the User List dialog box where you may add, modify, and delete users. This menu 
item only appears when the Administrator is logged in.

Related topics:
Adding users
Modifying users
Deleting users



View Filter
The View Filter feature of Message Center allows you to select a subset of messages to 
display based on specified criteria.

To filter the display of messages:

1
.

Select View Filter on from the View menu. The View Filter on 
dialog box is displayed.

2
.

The following filter settings are available:

Filter by Priority:

From:

To/Cc:

Subject:

Message:

When this check box is selected and the 
priority is selected in the list-box on the 
right, only messages with the specified 
priority are displayed.
Only messages originated by the specified 
user are displayed.
Only messages that include the specified 
recipient are displayed.
Only messages with a subject that contains 
the specified text are displayed.
Only messages that include the specified 
text in the message body are displayed.

When you have completed your settings, select the OK 
button.

3
.

When you wish to return to an unfiltered view, select View 
Filter off in the View menu.

Related topics:
The In Folder 
Searching for messages 
View menu



View Filter off

Turns off the previously set view filter for the current folder. Each folder (In, Out, and Sent) 
may have it's own view filter.

Related topics:
View Filter



View Filter on

The view filter allows you to specify criteria for which messages should be displayed in the 
current folder. Each folder (In, Out, and Sent) may have it's own view filter.

Related topics:
View Filter



View Folder

View Folder has a sub menu which allows you to switch among the In, Out, and Sent folders, 
although switching folders is more typically done by clicking on the folder tabs.

Related topics:
The In Folder
The Out Folder
The Sent Folder



View Next

Moves you to the next message in the current folder.



View Previous

Moves you to the previous message in the current folder.



View menu
Click on the area of the menu you would like more information about:



Viewing Filer folder attachments
Messages can have two types of attachments; PC files, and ZAURUS Filer folder 
attachments. You may view the contents of ZAURUS Filer folder attachments without first 
detaching them.

To view Filer folder attachments:
      

1
.

While in the detail view of the desired message, select the Attach 
button. The Attachments dialog box is displayed.

2
.

Select the desired Filer folder and then select the Modify button. The 
Import ZAURUS Filer Folder dialog box is displayed.

3
.

Select the entry you wish to view and then select the Quick View 
button. The Quick View dialog box is displayed and the attached data
is shown, along with the name of the application which uses the 
data.

4
.

If there is more than one entry in the Filer Folder, you may use the 
Prev and Next buttons to display other entries.

Related topics:
Adding attachments
Detaching attachments



ZAURUS Message Center Help Contents

The following Help Topics are available:
Main screen

Menus
Messaging

On the ZAURUS Printing
Communicating via IR/Cable Printing 
Sending Mail Print formats
Receiving Mail Print setup

On the PC Pager service settings
Creating and Sending Mail Pager filter     
Receiving Mail

Setup
Preferences setup
Communication setup     
Pager Service setup
Message Server setup

For Help on Help, Press F1






